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1.0 Introduction 
ClockWatch Enterprise is Beagle Software’s solution for networks that 
require a centralized control console.  Enterprise is bundled with 
ClockWatch Pro to collect correct time from external timeservers, then acts 
as a master time clock to set time on each registered client to set time.  A 
small software module is installed on each client to receive the command, 
but otherwise all control is maintained by ClockWatch Enterprise. 
 

1.1 Software Installation 
1.1.1  Choose which machine will be the timeserver 

• Console computer should have Internet or modem access in order to 
sync time with the Atomic Clock using ClockWatch Pro. 

• Computer must be accessible on the LAN to all clients. 
• Computer normally should be left running. 
• Does not have to be a domain controller or an otherwise special 

computer on the network. 
 

1.1.2  Install ClockWatch Enterprise software on the timeserver 
• Install the ClockWatch Enterprise program from CD-ROM or from the 

downloaded executable file. 
• Use the key code provided by Beagle Software (via email and/or on 

the back of the CD envelope). 
• After installing Enterprise, install the license upgrade utility provided 

by Beagle Software on the same computer for the total number of 
client licenses purchased.  

 

1.1.3  Install ClockWatch Pro time sync software on the timeserver 
(optional) 

• Install the ClockWatch Pro program from CD-ROM or from the 
downloaded executable file. 

• Use the key code provided by Beagle Software (via email and/or on 
the back of the CD envelope). 

 

1.1.4 Install the Client Service Module on each client 
The Client Service Module needs to be installed on each registered client.   

• Locate the file on the CD-ROM (\ClkWatch\CWEntM.EXE), or download 
the file from our website:  http://www.beaglesoft.com/CWFileXfer.htm 

• Install the Service Module on each client following the same 
procedures as ClockWatch Enterprise. 

• Start the service or application on each client.  The application or 
service module must be running to respond to requests from 
ClockWatch Enterprise. 
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Notes:   
• There is no need to reinstall over the trial software—simply enter the 

keycode to engage full functionality. 
• ClockWatch can be installed over a previously installed version or 

edition. Some options have changed, so you may need to reset some 
time setting or display options after starting the new software. 

• ClockWatch Enterprise does not have a built-in utility to remotely install 
on each client. 

 
1.1.5 Installing ClockWatch Enterprise as a  Service 
ClockWatch Enterprise can be installed as a Service under Windows® 
NT/2000/XP/2003. This allows ClockWatch Enterprise to run in the 
special service area of the operating system.   When running as a service, 
ClockWatch Enterprise does all the time checking and clock 
synchronization activities without intervention, running from the 
parameters specified by the user using the normal ClockWatch Enterprise 
application. 
 
To install ClockWatch Enterprise as a service 

1. Install and configure ClockWatch Enterprise on the system.  The 
service uses the ClockWatch Enterprise parameters you specify in 
the regular ClockWatch Enterprise interface. 

2. Register the Enterprise Service by choosing  Options>Service and 
selecting “Re-register”.   This will register the service with the 
operating system. 

3. You can start and run the service from either the Service Tab within 
ClockWatch Enterprise or by using the Services applet available in 
the Windows NT/2000/XP administrative interface. 

The Windows Services applet lets you start, stop, pause or continue the 
execution of services.  You can also use it to specify if you want 
ClockWatch Enterprise Service to be started automatically at boot time.  
 

1.2  Software Removal 
Removing ClockWatch Enterprise from a system will remove all 
executables, help files, log files, registry settings and DLLs that are 
registered exclusively to ClockWatch Enterprise. 
To Remove ClockWatch Enterprise (uninstall software) 

1. Exit ClockWatch Enterprise, stop all background instances of 
ClockWatch Enterprise. 

2. Select the Uninstall program (uninstall.exe) from the Start>Program 
Files>Beagle Software>CWEnterprise directory. 

3. Follow the uninstall wizard. Accept the defaults. 
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4. You may be asked if you want to remove shared DLLs.  It is safest 
not to remove the DLLs in case they are in used by another program. 

 

1.3 Enterprise Quick Start 
Start ClockWatch Enterprise program from:  Start>Program Files>Beagle 
Software>CWEnterprise 
 
Remote Timecheck 

1. Let Enterprise discover the computers currently on the network.  

2. Select the client to test or <all> from the pull-down menu in the 
Command frame. Select Timecheck and Press the Start button. 

3. The connection will be made to each client, each remote computer’s 
time will be checked, and the findings will be displayed in the client 
tree and in the data log and graph displays. 

 
Remote Timeset 

1. Allow Enterprise to discover computers on the network or manually 
add the client to the list of computers. It will be displayed in the 
client tree. Change the status of the client to Active by choosing 
Clients>Edit;  select the status option from the list. 

2. Select the client in the pull-down menu. Select Forced Time Set 
Press the “Start” button. 

3. Each remote computer’s time will be set to the time on the 
ClockWatch  Enterprise timeserver machine.  Individual settings will 
be displayed in the client tree and in the data log and graph display. 

 
Network Pinging 

1. Start ClockWatch Enterprise program from: Start>Program 
Files>Beagle Software>CWEnterprise. 

2. Let Enterprise discover the computers currently on the network.  

3. Select <all> in the Command frame for all clients in list, Ping and 
press the Start button. Enterprise will ping all listed clients. 

4. Each client will be pinged, the roundtrip connection time will be 
checked and the findings will be displayed in the client tree and in 
the data log and graph display.  

 

 



Beagle Software 

6 

2.0  User Guide 
This section of the User Guide describes how to use ClockWatch Enterprise 
for managing time synchronization on your local network.  For information 
on using ClockWatch Pro for external time synchronization, please see 
Section 6. 
 

2.1  Main Screen 
The Main Screen acts a central point for displaying client information and 
provides a base for running the ClockWatch Enterprise System. Visible 
from the Main Screen are the menus and the frames for Client Tree, Mode, 
Command, View, Clients, data log, and graphs.  You can customize the 
Main Screen using the View menu. 

 
 
Client Tree 
Shows the list of clients addressable by ClockWatch Enterprise. Exploding 
the node shows client properties and information about the last contact 
made with the ClockWatch Enterprise controller. 
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Properties 
Computer Name: Network name of the client (i.e., myclient) 

IP Address: Full IP address  (i.e., 122.20.25.5) 

Type: Client 

Protocol (NIST): Protocol used to communicate with client service 
module. 

Notes: Annotate client as desired. 

Last Contact 
Last contacted (date/time): Last time the client was communicated 

with. 

Total contacts (count): Total number of times the client has been 
communicated with for this session. 

Reply Delay (milliseconds): Roundtrip time to communicate with client. 

Time Difference 
Last checked (date/time): Date and time of the last time check. 

Time difference (seconds): Difference in seconds between the client 
and the host computer. 

Clock Setting 
Last setting (date/time): Date and time of the last time setting. 

Setting difference (seconds): Number of seconds that clock was 
changed on client. 

Accuracy (seconds/day): Accuracy of client compared with host. 

Status 
Last changed (date/time): Date and time the status was changed. 

Current status (active/inactive): Client activity status. Inactive 
clients are not included in general tests. 

 
Mode 
Select the mode under which ClockWatch Enterprise will work. The modes 
available include, Manual, Once, Daily, Periodic,  Schedule, and 
Continuous. 

Manual: run test on demand. 

Once: run once in the future. 

Periodic: run tests at a periodic interval. 

Daily: run test at the same time every day. 

Schedule: set up a schedule to run tests or commands. 

Continuous: run the same function continuously (for testing only). 
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Command 
The pull-down menu allows you to choose the client to test or select the 
<all> option to test all clients.  Press “Start” to initiate the command. 

Ping: Issue standard ‘ping’ request. 

Heartbeat: Check to verify that Service Module is up and running. 

Timecheck: Check the time on clients. 

Timeset: Set time on registered clients, if needed. 

Forced timeset:  Forces time set on client(s). 

Command: Run remote command on client(s). 

Relay: Turn switch contacts on remote relay module on or off . 

None: No action. 

Command window / next event time:  shows the current command or 
the date and time of the next command. 

Start: Starts the current function for the current client 
immediately from the settings on the control panel. 

Stop: (continuous mode) stops the continuous loop and 
returns to manual mode. 

View 
Arrange: Changes how the graphs are displayed in the order listed 

in the Windows menu 

Options: Opens the Settings tab of the Options screen, and allows 
easy access to the Options described in Section 3. 

Refresh: Refreshes graphs or data listings. 

Clients 
Add: Add a new client. 

Delete: Remove selected client. 

Save: Save the current client list. 

Edit: Open the client editor 

Refresh: Redraw the tree. 

Service 
Service: Shows if service is running (Green). Press to open Service 

options. 

Graph/Data 
Displays data logs, graphs, and schedule.  Change the arrangement of the 
current windows in the frame by pressing the Arrange button. 
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2.2  Guide to the Main Screen Menus 
 
File Menu 

Exit:   Exits ClockWatch Enterprise. Closes log file. If options 
were changed asks if changes should be saved. 

Clients Menu 
Add: Opens a window to enter the unique IP address of the 

new client. 

Edit: Opens a client list window; choose the client from this list 
and a client edit window will open.  Options are available 
to edit the client name, IP address, protocol, and add 
notes.  

Remove: Remove client from list. 

Save: Saves the client settings. 

Update: Applies any changes you have made. 

Refresh: Refreshes the client window on the main screen. 

View Menu 
Use this menu to customized the windows and panels you see on the main 
screen.  Choose the item from the menu to toggle the view on/off. 

Client Tree: Show the client tree; options for Clients only or View All 

Control Panel: Show the control panel frames for mode, command, 
view, clients. 

Data: Show client data. 

Graphs: Show the graph displays. 

Options Menu 
Select any item from the Options menu to open the Options window, or 
choose Options from the View Frame of the main screen. Detailed 
information on each option is outline in Section 3. 
Tools Menu 
Detailed information on the Tools menu is provided in Section 4. 

Client Test:   Opens up the client test screen to allow the administrator 
to test each client for diagnostics or troubleshooting. 

Search for Service Modules (NT/2000/XP/2003):   

 Finds computers running the Enterprise Service Module.  
First validates individual computers, then checks to see if 
the computer is currently running the Service Module. 
Results from the test are shown on the client tree. 

ClockWatch:   Starts the ClockWatch time sync program, if installed. 

 



Beagle Software 

10 

Windows Menu 
Cascade:   Displays open charts overlapping. 

Tile Horizontally:  Displays open charts stacked one atop another. 

Tile Vertically:  Displays open charts side by side.  

 
Help Menu 

Help Topics:   Displays a list of help topics. 

Search:   Search the help system for a key word or topic 

Using Help:   How to use help. 

Tips:   Opens the tip of the day Tip Screen  

Beagle Software Web Site:  Opens a web browser (if available) which 
opens Beagle Software's home page, 
www.beaglesoft.com. 

Register: Opens the main Registration Screen which explains 
the different ways you can register your software (trial 
version). 

Software Updates:  Opens a web browser (if available) which opens the 
ClockWatch Enterprise software update page. This 
page contains information about the most current 
version of ClockWatch Enterprise and the options to 
upgrade. 

About:   Displays version, number of clients system and 
program copyright information. 

 

3.0  The Options Window 
Choose Options from the View frame of the Main Screen, or select any item 
from the Options menu to activate the Options window.  This window is a 
gateway to customize a variety of options, described in detail beginning 
with Section 3.1. 
 

Setting: Customize the timeset settings. 

Display: Choose the graphs and panels to show. 

Function: Select the command functions 

Logging: Set logging on/off and establish file location 

Graph: Select the graph displays to show on the main screen 

Clients: Manage the client listings 

Service: Control the ClockWatch Enterprise service, if applicable. 
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Command Buttons 
OK: Closes the screen, saving any changes made. 

Cancel: Cancels the changes you are about to make. Any changes 
made to this screen will be cancelled. 

Help: Begins on-line help. 

 

3.1  Setting 
The Settings option allows users to select the mode under which 
ClockWatch Enterprise will work. The modes available include, Manual, 
Once, Daily, Periodic,  and Schedule. 

 
Picking the right Setting Mode 

• Use Manual when you want to make a setting quickly, providing for on-
demand settings only. 

• Use Once when you want to set the clock at a given time in the future, 
for example to synchronize with another computer or system.  Once 
at…  shows the date and time of next setting. 
 

When the Once option is selected, the Enter Time form will appear.  
From here you can set the time and date to perform a time check.  
This is the time that the next setting will be made.  The form allows a 
variety of time/date formats. 

 

Time Input Field:  Used to enter the time for the next setting. If the 
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setting mode is Once, then input is expected in the <date> <time> 
formats.  
Date formats:  Enter the date using a format that is valid for your 
region. For users in the US include month/day/year (i.e., 1/18/04) 
or in full month word format (i.e., January 18, 2004). 
Time formats:  Enter the time using a format that is valid for your 
region. US users can use either 12 hour AM/PM format (i.e., 1:15 
PM) or 24 hour clock basis (i.e., 13:15). 

Note:  Invalid date or time strings, including dates in the past, will not 
be accepted by the form. 
 

• Use Daily to maintain the clock accuracy at a reasonable level suitable 
for most users.  Every day at…:  shows the time that settings will be 
made each day.  When the Daily option is selected, the Enter Time 
Form will appear.  See the explanation for this in the Once setting 
section, above.  Note that Daily does not require a date setting. 

• Use Periodic when the accuracy of the system is crucial.  Periodic is 
appropriate for the most demanding environments when the clock 
must be kept within several seconds of standard time. 

Make settings every... (pull-down):  Choose the interval of time 
desired between settings. 

• Use Schedule to run a series of actions on a pre-defined schedule.  
See the following subsection for information on editing the schedule. 

 

Usage Notes:  If ClockWatch Enterprise is not connected to the client on 
the LAN at the specified time and direct modem connection is not used, 
then the setting will not be made nor will it be rescheduled. 
 

Minimum Time Change: The threshold value for client time change, in 
milliseconds. If the client exceeds this value when doing a Timeset 
function, then the clients clock will be changed, otherwise no time change 
will be made. Applies only to Timeset (not Forced Timeset) function. 
 
Warn when client time has not been checked every…<interval> 
ClockWatch Enterprise can warn you when a client fails to be reached 
during a timecheck or timeset. If the time on the client hasn’t been 
checked within a certain amount of time a warning is issued.   If the time 
since last successful check exceeds the interval limit entered, then a 
warning will be written to the Event log (if Event logging is enabled). The 
client must be in the current client list for the warning to be issued.  

Note: warning must be enabled to send email notification. 
 
Send Email Warning 
Enables email notification for clock check warnings (see above). When first 
checked opens up Email Notification Setup screen. 
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3.1.1 Editing a Schedule 
The Schedule Editor window appears on the main screen when the 
Schedule mode is selected.  It allows you to add and edit individual events 
in a schedule. The toolbar at the top of the window allows you to open, add 
and edit the events in the schedule.  Events can be selected for editing, 
viewing or playing.   
 
Event List 
Shows a list of events in the schedule. Events are played from top to 
bottom.  To select a Event in the list click the left column (the Event 
number) of the Event to select. 
 

Columns 
ID: Event number in current schedule. This number is assigned 

when the Schedule editor is started. If you change the order 
of the events then the next time the event editor is opened 
the numbering of the events will reflect the new order. 

Days: Days to run the event. Choices include all, individual days, 
M-F, Sat-Sun. 

Time: Time the event will start. Time is in 24 hr format (hh:mm). 

Client: Client to be contacted, with option for <all>. 

Function: The function to run. 

Command: If a command, the command string to run. 

 
Editing Toolbar 
The Schedule Edit toolbar contains the major options for editing Events 
and Schedules. 

Save: Save the current schedule changes to the file. 

Edit: Edit the document, sound file or pause time for the event. 

Add: Create a new event at the end of the schedule. 

Copy: Create a copy of the highlighted event below the existing 
event. 

Insert: Insert a new event immediately below the current event. 

Skip: When running the schedule, skip this event.  When an event 
is designated as skipped, the icon changes to a yellow 
warning icon; these events remain in the schedule but are 
not played in the schedule. Upon reopening the schedule, 
skipped events are reset to the normal play mode. 

Delete: Delete the event from the schedule.  This does not delete 
the original image or document, just the reference to the file 
in the schedule. 
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Hints 
• Double click the event to open the Edit Event form. 
• Expand/contract the Schedule Editor window by dragging any 

edge of the window.  

• Right-click the mouse to show the Editing Toolbar options in a pop-
up menu. 

• Schedules can be alphabetically sorted by any of the column 
headings by clicking on the column title. 

 
Add/Edit Event  
The Event Edit screen allows you to specify the time, days of the week the 
client and the function you want to run on a regularly schedule basis.  

 
Days to run:   Days to run the event. Choices include all, individual 

days, M-F, Sat-Sun. 

Start time:   Time to start the event. Time is in 24 hr format (hh:mm). 

Client:   Client to be contacted, with option for <all>. 

Skip Event:   Skip the event when running the schedule. 

Function:   The function to run 

Command:   When using a remote command or Relay module, shows 
the arguments used. 

Change button: Opens up the command edit screen 
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3.1.2 Command Line Mode  
ClockWatch Enterprise can be run from the command line allowing it to be 
called from another program. 
 
If you launch ClockWatch Enterprise from the command line (Windows 
95/98/Me Run command or MS-DOS prompt) and want the program to 
run once and exit without user intervention, use the once command 
argument: 

CWEnterprise 
<program_path> CWEnterprise.exe  once 

 

to run in the unattended mode, where  
• <program_path> is the path where the executable is located,  

• CWEnterprise.exe is the executable and  

• once is the command line option.  

 
This is equivalent to starting the program in the Manual mode, pressing the 
“Start” button and exiting.  
 
To start ClockWatch Enterprise in the normal, attended mode, omit the 
once argument. 
 

3.2  Display 
The Display tab offers display options for the Main Screen.  Click the box 
next to each item to enable the feature; click again to disable. 
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Display Options 
Display Control Panel:  Show the control panel in the main screen. 

Show Action Data:  Show the action event log in the Graph/Data panel 
of the main screen. 

Show Tips at Startup:  Turn on /off Tip screen at application startup. 

Startup Automatically:  Start the  ClockWatch Enterprise application at 
computer startup along with other background applications, and is 
shown in the system tray.  The ClockWatch Enterprise clock icon 
indicates the stay resident program is loaded and running in the 
background.  Note:  if this option is selected, you cannot edit the 
Graphs tab. 

Show Graphs:  Turns the display of graphs on or off.   Note: Data in 
graphs are hidden if display is turned off but no data are lost. 

 
Client Tree Options 
These options determine which computers (clients) are displayed on the 
client tree on the main screen.   A client can be considered either: 

• Active:  running the Service Module,  

• Passive:  visible on the network but not running the Service Module, or  

• Inactive:  disabled or not visible on the network. 
 
Display Client Tree:  when checked, shows the client tree in the main 
screen. 
 
Show All Computers:  Lists all clients currently visible on the network. 
 

Validate Clients:  Tests clients on the network before listing them. 
Specifically, checks to see if individual clients will respond to a network 
time check request.   Clients responding to the time check will be classified 
as Passive, clients failing to respond to the time check will be set as 
Inactive. The results of the check will be shown on the computers on the 
tree.  Use the next two options to change the inactive or active client listing 
based on these results.   
Note: In order to run the validation check, clients must have sharable 
access over the network. 
 
Delete Inactive Clients:  Delete clients that fail validation or that are 
manually set to inactive. Note: when inactive clients are deleted they are 
dropped from the client list and will not be seen unless they reappear on 
the network or are added manually. Use this setting to show only the 
computers currently live and accessible on your network. 
 
Save Active Clients:  Does not delete Active clients, even if they aren’t 
currently visible or accessible over the network.  Use this setting to 
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preserve the listing of clients running the Service Module that aren’t always 
turned on or otherwise available on the network. 
 

3.3  Function  
The Function tab offers choices for the command and the client to set. 
 

Command: Which command to run from the list of command options. 

Client:   Choose the client to run the command on, or all. 

Command:   Optional arguments for the command or Relay module 
setting. 

 
Command Summary: 

Ping: Pings clients. 

Heartbeat: Checks for heartbeat from client. Uses functionality of 
Service Module on client for check. 

Timecheck: Checks and reports current time on the client. 

Timeset: Sets time on client, if necessary. Clients with more than 
one second difference from Enterprise are set. 

Forced timeset:  Time set on client with time on Enterprise, 
unconditionally. 

Command: Execute a command on a client.   

Relay: Sends an Relay command to a control module attached to 
a client.   

None: No command issued. 
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3.3.1 Command Edit  
The Remote Command screen, accessible by choosing Command from the 
Function tab, lets you specify a remote command to run on a client. This 
includes applications, MS-DOS batch files and commands. You can also 
specify a remote Windows shutdown.  When used in conjunction with Relay 
device control you can do a graceful hardware and software reboot from a 
remote location 

 
3.3.1.1  Remote Command 
Specify the command to run remotely. You can press the “Browse” button 
to find the correct name and complete path. Since the command will be 
executed on the remote computer the path should read as if you were 
sitting at that computer, issuing the command. 
 
3.3.1.2  Remote Windows Shutdown   
Request (or force) a Windows shutdown, logoff or reboot on a remote 
computer running the ClockWatch Enterprise Client Service Module.  Since 
the shutdown is executed by the Service Module, it must have the 
necessary permissions to shutdown the computer. 
 
There are several shutdown options, including forced and power down, to 
remotely suggest or force a shutdown.  

Logoff:   Logs off current user. 

Shutdown:   Shuts down the computer. 

Reboot:   Shuts down and reboots the computer. 

Power-off:   Brings computer down to the power down state. 

(forced):   Forces the above action on the remote client, 
regardless of the activity of the current user. 

 
Whether the computer will go to the power down state will depend on its 
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ACPI capabilities and settings.  ACPI (Advanced Configuration and Power 
Interface) is an industry specification for the efficient handling of power 
consumption in desktop and mobile computers. With ACPI, the computer 
can enter a stand-by mode when no one is using it. 
 
ACPI must be supported by the computer motherboard, basic input/output 
system (BIOS), and the operating system.  One of several power schemes 
can be chosen.  Within a power scheme, the user can control the power to 
individual devices.  ACPI is designed to work with Windows 98/ Me/2000/
XP/2003.  If you have ACPI enabled Windows, you'll find a description of 
ACPI in the help file. 
 
Shutdown With APCI Compatible computers 
Send shutdown command using the remote Windows shutdown command 
within ClockWatch Enterprise. The computer must be running the 
ClockWatch Enterprise Service Module. This should place the computer in 
the powered-down state. 
 
Shutdown With Non APCI Compatible computers 
Send shutdown command using the remote Windows shutdown command 
within ClockWatch Enterprise.  The computer must be running the 
ClockWatch Enterprise Service Module.  This should place the computer 
shutdown but powered on state.  Turn the power off to the computer with 
the Relay module.  See Section 3.3.2 Relay module  requirements and 
procedures. 
 
3.3.1.3  Wake On LAN 
Wake-On-LAN (WOL) capability allows you to start a WOL ready computer 
from a signal issued from a remote computer.  WOL capable computers 
have WOL network cards that listen for the special WOL magic packet.  In 
order to use the Wake-On-LAN feature, your target computer must meet 
the following requirements: 
 

• Have an ATX motherboard with an onboard, 3-pin WOL connector. 

• Have an ATX ONLY power supply that meets ATX 2.01 specifications. 
The critical part is the 5V standby current, which must be at least 800 
mA. 

• A network card that can support WOL with its cable to the motherboard 
properly installed. 

• In the BIOS Power Management, you must enable the LAN Wakeup 
option. 

• Your system must be in a Soft-Off power state. 

 
Note: ClockWatch Enterprise does not need to be installed on the target 
computer since the network card listens for the WOL packet. 
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Using Wake-On-LAN 
• Verify that the target computer supports Wake-on-LAN (see above). 

• Using the remote command function in ClockWatch Enterprise, send 
the broadcast IP address and the network card device address (MAC 
address) to a computer running the ClockWatch Enterprise Service 
Module. 

• The computer running the Service Module sends the magic packet 
across the LAN to the target computer currently powered down. 

• Upon receiving the magic packet from ClockWatch Enterprise, the 
computer will wake up and boot the system. 

 
WOL Setup Definitions 

Broadcast IP:   IP address of the target computer. Use 
255.255.255.255 to broadcast to all computers on 
a subnet. 

Local Adapter IP:   IP address of the local host adapter.  This field can 
be left blank.  If there is only one host adapter 
installed on the computer this field can be left 
blank. 

MAC address:   The specific MAC hardware address of the LAN card 
on the computer to be started. This is unique 
hardware address specific to the adapter card. 

Tip:  You can check the MAC address by running ipconfig /all from the 
command line. 
 

3.3.2   Relay Setup  
The optional Relay module allows you to turn a remotely connected relay on 
or off over the LAN or Internet. It requires that a Relay module be 
connected to the remote client (which is connected via serial port to the 
Service Module software). The Relay Module can be used to control a 
variety of AC or DC powered devices including computers, peripherals, 
lights, and instrumentation. 

Switch 1 or Switch 2 - Directly controls the two SPDT relays. 
On/Off: sets switch to on or off position 
Latch: makes new switch position change permanent 
Interval: Make the new switch position for the number of seconds 
specified. For example, setting ‘Switch 1 On’ for an interval of 20 
seconds will temporarily make the contact on switch number1 for 
20 seconds and then return it to the off position. 
Data In: sense and detect the voltage input level.  
Com Port: The number of the COM or serial port connecting to the 
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Relay module interface installed on the remote client. 
Baud Rate: Baud rate of the serial connection to the Relay module 
(normally 9600 baud). 
Test – opens the Relay Test screen (must have the relay module 
attached locally) 

 

3.3.2.1 Relay Test Screen   
This screen allows you to test a locally connected Relay module. You can 
issue simple commands to open, close switch contacts and sense the 
current status of the Relay module.  
Note: Commands for remotely connected Relay modules should be 
made in the Relay Setup screen. 

On/Off: sets switch 1 or 2 to on or off position 
Read Input: read voltage on the input terminals. Latch shows that 
setting has been made. Reset resets the sampling cycle. 
Xfer Stat – shows transfer status with Relay interface (green shows 
active transfer) 
CTS – Clear to send status line (green when CTS is holding). 
RTS – Ready to send status line (green when RTS is holding) 
Com Port 
The number of the COM or serial port connecting to the Relay 
module interface installed on the remote client. 
Baud Rate 
Baud rate of the serial connection to the Relay module (normally 
9600 baud). 

 
 
3.3.3  Network Monitoring 
ClockWatch Enterprise has built in network monitoring features that can 
work in your multi platform environment.  ClockWatch Enterprise allows 
you to easily monitor computers on your network and quickly determine if 
computers are running and/or responding.  
 
The network monitoring functionality in Enterprise can be broken down into 
two types: active and passive.  The active client runs the Enterprise Service 
Module and can respond to specific requests from ClockWatch Enterprise. 
In the passive case there is no Enterprise software loaded on the client. 
Instead, the client responds to standard network requests, such as 'ping'.  
Enterprise should be able to communicate with any computer on the 
network, but can conduct the most functions with active clients. 
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Enterprise's monitoring capabilities by platform type 

 
 
3.4  Logging  
The Logging tab allows the administrator to turn on/off the system logging 
and, when enabled, set the log file name and location.  The log provides a 
record of all the settings made on the system. This can be useful as a 
record of system performance and/or as an input to other programs such 
as a spreadsheet or database programs where further analysis would be 
done. 
 
Once a log file is specified ClockWatch Enterprise will add data to the log 
file each time the program is activated and a setting is made. The log file 
will record every “0” setting where the clocks were in sync, but will not 
record setting attempts when the connection failed. Old data from previous 
sessions are preserved as the recent data are appended.  A log file must 
be specified for the Previous Settings Graph to show data. 
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Windows 
Computers 

without Service 
Module Installed 

 
 

Non-Windows 
Computers 
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Logging 
To file:  Turns on the log file for client time setting and action. 
Off:  Turns all logging off and stops writing to log file.  This does not 
remove any existing log file. 
Time Setting Attempts 
Indicates the file name/location for log entry when a client is contacted 
for time setting. 
File Name Field:  Contains the full file name and path of the log file.  
(i.e., c:\program files\beagle software\cwenterprise\logfile.txt).  Enter 
the file name in the field or press the Browse button. This file must be 
specified for the Previous Settings Graph to show data. 
View:  Opens up the log using Windows Notepad. Note:  if there have 
been no setting attempts, there will be no file to view. 
Browse:  Presents the find file dialog to locate an existing file in the file 
system. 

 
Action Log File 
Indicates the file name/location for every action or event that occurs for 
each client. 

File Nme Field:  Contains the full file name and path of the action log 
file. (i.e., c:\program files\beagle software\cwenterprise\eventlog.txt)  
View:  Opens up the log using Windows Notepad. Note:  if there have 
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been no setting attempts, there will be no file to view. 
Browse:  Presents the find file dialog to locate an existing file in the file 
system. 

See Section 6, Technical Reference, for sample file formats and 
status result codes. 

 
Event Logging (Windows NT/2k/XP/2003) 
Event logging allows you to write selected actions to a text file and the NT 
event log. This log captures major time setting activities as well as 
warnings for when there may be a system or time setting problem. With the 
event log enabled Enterprise will capture the events you specify as well as 
any operating errors. 
 

To view the Windows NT Event log open up the NT event reader and select 
‘Application’. Entries will be listed under “CWEnterprise” for the application 
and “CWEntSrvc” for events generated by Enterprise Service. 
 

Log to NT event log:  When checked, Enterprise writes events to the NT 
event log. 
Start time check:  Logs when the time checking or setting process is 
started. 
Time check result:  Logs the result of time setting activity with each 
client. 
Problem Cases: 

Connection to client fails:  Logs when Enterprise is unable to 
contact the client. 

Time difference when it exceeds  <interval> seconds:  You can 
specify for Enterprise to log an event if the time difference exceeds 
a threshold limit value.  Insert the threshold time (in seconds) in 
the box. Whenever the difference between the client’s time and 
host time exceeds this value an event entry will be made. 

Syslog: when checked, ClockWatch also writes events to a remote 
Syslog server. When option first checked, opens up Syslog Setup 
screen. 

Syslog Setup  
ClockWatch Enterprise can send events to a remote syslog server. Syslog 
servers, common in UNIX and Linux networks, gather messages from a 
variety of sources such as routers, switches, and any other syslog enabled 
application or device.  The syslog server filters, stores, displays and 
forwards messages gathered locally and from the network. 
Server tab – specify the syslog server. 

Syslog Server: Enter the name or IP address of the remote syslog 
server. Note that the server must have remote syslog messaging 
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enabled and must be accessible over the TCP/IP connection. 
Test  tab -  allows you to send a test message to syslog to confirm the 
settings and connection. 

Level: Choose the urgency level you want the test message to be 
sent at.. 
Test Message: Text of the test message. 
Test button: Press the Test button to send the test message to the 
current options. 

Usage Notes: 
• Remote syslog logging must be enabled on the receiving computer. This allows 

the Syslog server to receive messages from the network using an Internet 
domain socket with the syslogd daemon in UNIX/Linux. 

• Syslog uses UDP port 514 for communication. This port must be open on both 
the sending and receiving computers.  

• Enterprise sends messages at either the information, warning or error level 
priorities. Messages are sent to the NTP subsystem of Syslog. 

• Event logging must be enabled in Enterprise to generate messages for remote 
Syslog logging. You can choose the type of events to log on the Logging and 
Clients tab in Enterprise. 

 

3.5  Graphs 
The graph tab offers options for displaying the computer clock 
performance graphs and options on charting the data.  

 

Note:  Select “Choose Graphs Automatically” to set default options. 
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Client Contact  
Reply Count:  Number of times clients have been contacted by any 
function during this session. 
Response Speed:  Roundtrip response time (in milliseconds) to client 
and back. 
Last Contact Date:  Date last contact occurred since session began.  
Bar chart showing last client contact since session began. 

 

Time Check  
Clock Difference:  Time (in seconds) client clock deviates from 
Enterprise host. 
Last Checked:  Bar chart showing the last time the client’s clock was 
checked. 
Clock Drift:  How much time, in seconds, the client’s clock has drifted. 

 

Time Setting  
Setting Diff:  Amount of time (in seconds) client clock was off from host 
at last time setting. 
Last Set:  Bar chart showing the date the clock was last set. 
Accuracy:  Accuracy of clients in terms of seconds/day of time loss or 
gain from the timeserver. 
Current Settings:  Shows the amount of time client clocks have 
changed since the session began.  The data point setting can be 
customized. 
Previous Settings:  This graph shows the settings made on previous 
settings. 
Ignore Zero Differences:  If checked, displays only the settings when 
the internal clock was changed. If not selected, shows all settings, 
including those when the clock was not changed (0 difference), in the 
Previous Settings graph. 
Data points on chart:  Sets the number of readings from the current 
session that is displayed on the bottom axis of both charts. Use a small 
number if you want the most recent settings only. 

Note:  Data points are shown for settings made since the application was started 
for the Clock Drift and Current Settings graph. The number of data points 
determines how many points to display in the Previous Settings graph. 

 

Status 
Status Type:  Bar graph displaying active or inactive status by client. 
Status Change Date:  Bar graph displaying date of last change in 
status. 

Note:  Turning graphs off will also stop the Graphics Server from running. This 
server is used to display the graphs used by ClockWatch and other applications. It 
is stopped whenever all applications no longer have use for it. 



ClockWatch Enterprise User Guide 

27 

3.6  Clients 
The Clients tab allows the administrator to manage clients.  This is an 
optional interface to the Clients menu on the main screen.   

 
Clients 

Add Client: Opens a window to enter the IP address for a new client. 

Remove Client:  Removes the selected client. 

Edit Client: Opens a window showing registered clients.  Double-click 
a client to open an editing window.   

See Section 3.6.1 for more information. 
 
List Clients by 

IP Address:   The clients will be listed in the ClockWatch Enterprise 
Client Tree frame by IP address. 

Computer name:  The clients will be listed in the ClockWatch 
Enterprise Client Tree frame by computer or network name. 

 

Note:  when switching between IP Address or name listing, Enterprise must 
be restarted to display the changed setting on the main screen graphs. 
 
Client Communication Port  
The administrator may specify the port number used to communicate with 
ClockWatch Service Modules. The default value is 1001. ClockWatch 
Service Modules normally listen for instructions from ClockWatch 
Enterprise.  This port connects with the client. 
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Network Domain (Win NT/2k/XP/2003) 
The shows the domain name or workgroup name for the network that 
Enterprise is monitoring. Enterprise will search this domain when looking 
for computers on the network. The name will appear automatically, but can 
be changed to point to a different domain. 
 
Client File List 
Shows the file name and location for the client list file (i.e., c:\program 
files\beagle software\cwenterprise\clientlist.txt).  The administrator may 
change the name or location of this file. 
 
3.6.1 Edit Client and Client List 
The Client List window is activated by selecting Options>Clients>Edit 
Clients.    This window allows you view and edit your client list.  

 
Toolbar 
The toolbar at the top of the screen allows you to edit changes to client 
computers in the directory. 

Save: Save the changes to the current client directory. 

Edit: Edit the name, location or protocol of the client. 

Add: Add a new client at the end of the list. 

Copy: Create a copy of the highlighted client below the existing 
client. 

Insert:  Insert a new client immediately below the current client. 

Delete: Delete the client from the directory. 

Columns 
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ID: Sequential index number in current directory, assigned 
when the directory editor is started. If you change the 
order, the numbering of the clients will reflect the new 
order the next time the client editor is opened. 

Name: Network name of the client 

Addr: IP address of the client. 

Protocol:  Protocol used to communicate with ClockWatch 
Enterprise. 

Type: Client. 

Status: Active, passive or inactive. 

Stat Date: Date of last change. 

Notes: Optional documentation. 

Setting Diff:   Difference in seconds from the time at last setting. 

Setting Date:  Date last time setting occurred. 
 

Hints  
• Expand/contract the client list and form by dragging the right or 

left edge of the screen. 
• Selected clients can be deleted, copied, viewed or played from the 

toolbar, or by right-clicking with the mouse. 
• Listing can be alphabetically sorted by any of the column headings 

by clicking on the column title. 
• Double-click a client to open its Client Edit window. 
• A single right-click of the mouse will give the client edit options in a 

pop-up context menu. 
 
Client Edit 
The Edit Client window is activated by double-clicking on a client in the 
Client List. 

   
Client name: Enter the URL or IP address of the client (i.e., time-
a.nist.gov). 
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IP Address:   Enter the full IP address (i.e., 192.123.22.34). 

Client Protocol:  Select the time sync protocol used to communicate 
with ClockWatch Enterprise. The default choice is NIST. 

Active/Passive/Inactive:  Shows if client is currently active and in use 
by ClockWatch Enterprise.  Active clients have the service module 
installed; passive clients do not; inactive clients are not checked. 

Notes:   Optional field to identify location of the client, i.e., MIS Exchange 
Server. 
 

3.7  Service (Win NT/2k/XP/2003)  
The Service tab shows status of the ClockWatch Enterprise Service and 
allows you to stop and start the service.  In Windows, a service is a 
separate process that runs independently of any application and is 
normally active whenever the computer is running.  When enabled, the 
ClockWatch Enterprise Service runs whenever the computer is running. It 
functions identically to the Enterprise application or service module. 
 

 
 

Start: Starts the ClockWatch Enterprise Service that is not 
running. The ClockWatch Enterprise Service accepts one 
optional startup parameter, debug, which gives a detailed 
trace of the ClockWatch Enterprise Service in the 
Debug.txt file in the CWEnterprise application directory. 

Pause/Continue:  Suspends/Resumes the clock synchronization 
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activity of the ClockWatch service. 

Stop: Stops the Enterprise service that is currently running. 

Status:   Shows the current run status of the service. 

Register: Register the Enterprise Service Module service with 
Windows.  

Notes:   
• You can also view the status, start and stop the service from the 

Service Applet in the Windows Control Panel. 

• ClockWatch Enterprise Service must be run in the System context.  

 

4.0  The Tools Menu 
The Tools menu directs you to run client tests, search for client service 
modules, and run ClockWatch to synchronize the server’s clock to the 
Atomic Clock.  See Section 6 for detailed information on using ClockWatch 
Pro/Server. 
 

4.1  Client Test  
The Client Test allows the administrator to test each client for diagnostics 
or troubleshooting.  The following activities can be tested: 
 
Confirming Settings in ClockWatch Enterprise 
Open the Client Test form to show the current server settings in Enterprise, 
which includes the server, protocol and port number used to communicate 
with the client. The current settings are used to set the initial test 
conditions. Pressing the “test” button will verify that the communication 
can be established with the current settings. 
 
Troubleshooting Connection Problems 
If a problem occurs where time setting does not work with a certain client, 
then the tests can be used to communicate with the client in a variety of 
common ways, as well as diagnose problems with communicating over the 
LAN, network or through a proxy server.  
 
Testing New Client connections 
The client test utility lets you determine if a new client is active and can be 
communicated with using standard protocols. A new site can undergo tests 
to see that the address is valid and that the Client Service Module is 
installed and running. 
Client Test Screen  
This is the main test screen for conducting client communication tests. 
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Test Features 

• Checks client access and connection with three different tests. 

• Shows the response of the individual client. 

• Includes name lookup test and ping test to check for basic 
accessibility of the client. 

 
The Client Test lets you check both the connection and the capability of 
local or remote clients.  Compatibility and connection problems can be 
diagnosed using the built in 3-point connection test.   
 

Client Section  

Address:  Name or IP of the client which will be used for testing. 

Protocol:  Time sync protocol used to communicate with this client. 

Port:  Number of TCP or UDP port used to communicate with client. 
 

Test Request Section:  Choose tests to run on client. 

Protocol:  Name of the test to run. 

Test:  Check to select the individual tests.  All tests may be selected. 

Resolve name:  Check that network name can be resolved to an IP 
address. 

Ping:  Common connection test to verify connection to a remote 
client. The ping utility uses the ICMP echo request and echo reply 
packets to determine whether a particular IP system on a network 
is functional. 

NIST:  Time-sync protocol used to communicate with the National 
Institute of Standards & Technology. 

T/U:  Whether the test uses a TCP or UDP type connection. 

Port:  Port number used to communicate with client in test.  
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X:  Toggle all tests on or off. 

Test button:  Start to run the tests selected from top to bottom. 

Cancel button:  Cancel any remaining tests (will finish current test). 

Timeout Interval:  Interval, in seconds, to wait for the client to respond 
for each test. If the client does not respond within the interval then the 
test fails. 

Test Results Section:  Shows the results of the communications tests. 

Pass (Gd) Test Checkmark:  The client has responded to the test 
with the appropriate response. 

Fail (Bd) Test Checkmark:  The client has failed to respond to the 
test on the port specified, or the response was in an unexpected 
format. 

Remarks/Data:  The string returned by the client or the results of 
the test.  
Directory Button:  Open the client directory list. 

 

4.2  Search for Service Module 
Select the “Search for Service Module” option in the Tools Menu to run a 
search of computers on the network that are currently running the Service 
Module.  The results are displayed in the Client Tree on the main screen. 
The status of clients with running Service Modules is set to “Active”. 
 
The module is intended to work in the background and has a simple user 
interface, described in detail in Section 5. 

 
5.0  Client Service Module 
The Client Service Module, installed on network clients, provides run-time 
support for ClockWatch Enterprise’s advanced features.  Once installed on 
a client computer it provides the interface for polling the client to check or 
set  time, and provides a means to carry out remote commands and 
actions.   
 
Installation instructions for the Client Service Module are described in 
Section 1.0.4. 
 

Status Window:  Shows the current status of the service module or the 
last request from ClockWatch Enterprise (see next page). 
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Client Service Module Main Screen 

Menus 
File  Register Service:  Registers the Service Module Service. 
 Exit:  Exits the service module. Choose whether to 

minimize and return to the system tray or to exit from the 
program completely. 

 

Options Port number:  Specify the port number used to listen for 
requests from ClockWatch Enterprise. This is the TCP or 
UDP port used in communication with the Server. Must be 
the same number as the port used in ClockWatch 
Enterprise for client communication. Default value is 
1001 
Protocol: choose either NIST (default) or SNTP protocol 
used to communicate with Enterprise console. 

 Startup Automatically:  When checked starts up the 
service module whenever the regular user logs in. 

 Service:  Opens the Service control  tab. 
 

Help Help Topics:  Opens ClockWatch Enterprise Service 
Module help. 

 
 

6.0 Using ClockWatch with 
Enterprise 
Beagle Software's ClockWatch Pro provides a fast and easy way to 
synchronize the computer system's clock to the Atomic Clock using the 
Internet or a modem.  
 
ClockWatch queries a timeserver you specify, which returns the exact time. 
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ClockWatch then converts the standard time to local time and compares it 
to the internal system time on the computer, adjusting the system clock if 
necessary.  Settings can be made on demand, on a regularly scheduled 
basis or automatically based on the specific need of the local system.   
 
Results from clock settings are displayed on windows and charts showing 
the overall accuracy of your computer.  Settings can also be logged to a file 
allowing you to save all activity in a text file for later review or archival.  
 
ClockWatch features multiple options for time settings, display, connection, 
logging, and graphs. 
  

ClockWatch Quick Start 
1. Install ClockWatch as described in Section 1.0.3. 

2. Make sure the computer has an Internet or modem connection 
established and that the time zone is set correctly in the Date/Time 
area of the Windows Control Panel. 

3. Start the ClockWatch program from:  
Start>Program>Beagle Software>ClockWatch. You can also start 
ClockWatch from the Tools menu in Enterprise. 

4. Press the Set Time button on the main screen. ClockWatch will use 
the default timeserver settings. 

5. The connection will be made, the time will be checked, and the 
findings will be displayed in the status windows. The internal 
computer time will be adjusted, if necessary. 

6. If a connection is not immediately made: 

• Verify that the Internet connection is intact (for example, check to 
see if your browser is loading web pages). 

• Choose the Options menu from the ClockWatch Main Screen, then 
select the Timeserver tab.  In the Source frame of this window, 
select “Directory.”  Choose another timeserver, click OK, then try 
to set time again. 

 

6.1  Time Sync Options 
ClockWatch may be set to sync time using the Internet or a modem.  For 
alternate synchronization options, consider ClockWatch Star Sync (GPS) or 
Radio Sync (WWVB) editions .   
 
This section offers a brief introduction to the base ClockWatch software.  A 
detailed ClockWatch user manual is available for download at 
www.beaglesoft.com. 
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6.1.1 Settings 
Use this window to establish how you want to sync time using the Internet. 
 

Manual:  Use when you want to make a setting quickly, providing for 
on-demand settings only.   

Once:  Use when you want to set the clock at a given time in the future.   

Daily:  Use to sync at the same time every day.   

Periodic:  Schedule settings with specific, fixed timed intervals between 
settings.   

Auto:  Best used when the desired level of accuracy is known and the 
time drift is relatively constant. It is used for Internet only.   

 
Warn me when time has not been checked every… 
ClockWatch will monitor the last time a time check was made. If the last 
check exceeds the interval limit selected, then a warning will be shown in 
the Log Window and in the system tray icon.  
 

Check time once and then exit 
When enabled, ClockWatch will check the time once using the Internet and 
then exit. 
  

Force Time setting  
When enabled, ClockWatch will make a time setting every time the clock is 
checked.  
 

Configuring for Auto Startup 
ClockWatch can be operated in an unattended mode from the System Tray.  
To enable auto startup, choose Options>Display>Startup Automatically.  
When this option is checked, ClockWatch automatically loads and operates 
in whichever mode it was last configured and then runs in the background.  
The ClockWatch Pro icon will be available in the System Tray after 
ClockWatch is loaded.  
 

Usage Notes 
• On Windows 9xMe machines ClockWatch Pro starts on system boot-

up. 

• On Windows NT/2000/XP/2003  machines ClockWatch Pro is started 
when the local user logs in to Windows. 

• Windows NT/2000/XP/2003 users should consider using the 
ClockWatch Service, available as part of ClockWatch Server. 
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6.1.2 Timeserver 
The Timeserver tab offers a choice for the Internet timeserver used and 
type of connection to the timeserver you will be using. You can choose an 
NIST, NTP, Time or Daytime timeserver. You can also connect directly to the 
server over the Internet or through a proxy server. If an Internet connection 
is unavailable then you can call the NIST directly on the phone using the 
computer’s modem. 
 
Connection Frame options  

Internet/LAN:  Communicates directly to the specified timeserver over 
the Internet, using the protocol and port specified. 

Internet/Dial up:  Will first dial your ISP to make a connection to the 
Internet and then sync the clock using the timeserver specified.  For 
configuration options click Setup.  

 
Internet Connection Setup 
Click the Setup button o configure how ClockWatch will make connection 
with the Internet; opens the Internet connection screen.  ClockWatch offers 
several connection options: 

Manual Connection:  If you establish the connection to the Internet 
manually, or you normally are connected to the Internet over a LAN or 
on demand methods such as DSL or cable modems, you should 
choose the manual connection option. 

Have ClockWatch wait for Internet connection:  Use this option if you 
want ClockWatch to wait for the next time you make a connection to 
the Internet.  

Have ClockWatch Automatically Dial my ISP:  You can have ClockWatch 
dial your ISP to make an Internet connection when needed.   

Direct modem connection:  When selected, uses the modem to call the 
NIST directly and sync up time signals over the phone line. When 
selected, ignores the other options in this frame.  

 
6.1.3 Graphs 
The Graphs tab offers options for graph display and data charting of 
computer clock performance when using the Internet.   ClockWatch has 
three graphs:  Current Settings, Clock Drift, and Previous Settings. 
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6.1.4 Logs 
The log file shows information about setting attempts made.  You can 
choose to enable logging and specify the log file name and location.  
 

The Clock Setting log provides a record of all the settings, made on the 
system. This can be useful in a variety of ways: 

• To store previous setting attempts for use by the Previous Settings 
Graph. 

• As a record of system performance. 

• As a long term indicator of System Clock Drift over time. 

• As a source of information on when Internet access is available. 

• As an input to other programs such as a spreadsheet or database 
programs where further analysis would be done. 

 
Once a log file is specified, ClockWatch will add data to the log file each 
time the program is activated and a setting is made. The log file will record 
every “0” setting where the clocks were in sync but will not record setting 
attempts when the connection failed. Old data from previous sessions will 
be preserved as the recent data is appended.   
 
Event Logging  
Event logging allows you to write selected action to a text file and/or the 
NT/2000/XP/2003 event log. This log captures major time setting 
activities as well as warnings for when there may be a system or time 
setting problem. With the event log enabled, ClockWatch will include the 
events you specify as well as any operating errors. 

Event Log (on/off):  Turns all event logging on or off. 

Event File Name (field):  Contains the full file name and path of the 
event file, (i.e., c:\program files\beagle software\clockwatch\ 
eventfile.txt).  Select the default file name and location or choose your 
own.  Use the Browse button to specify the location.  This file must be 
specified for Event logging to work. 

Log to NT event log: When checked, ClockWatch also writes events to 
the NT event log. 

Log these Events:  Specify the events you want included in the text or 
NT event log. 

Normal Cases: 
Start time check:  logs the timeserver and when the time setting 
process is started 
Time check result:  logs the result of time setting activity 

Problem Cases: 
Connection to timeserver fails:  logs when ClockWatch is unable 
to contact the timeserver (after all retries). 



ClockWatch Enterprise User Guide 

39 

 
Time change when it exceeds  <interval> seconds:  You can specify for 
ClockWatch to log an event if the time change exceeds a threshold limit 
value.  Insert the threshold time (in seconds) in the box. Whenever the 
difference between the system time and standard time exceeds this value 
an event entry will be made. 
 
6.1.5 Bios Clock 
The BIOS Clock Options tab in ClockWatch allows the user to set how often 
the Computer’s clock is updated from the BIOS clock.  
 

The BIOS clock is the native PC clock located on the computer’s 
motherboard that keeps time when the computer is off. Windows gets its 
time from the BIOS clock at boot time. While not a precise timekeeper, the 
clock on the motherboard is generally more stable than the operating 
system clock.  
 

ClockWatch allows you synchronize the operating system clock with the 
BIOS clock. Computers experiencing significant daily time loss will find this 
an effective way to stabilize their clocks between external time settings. 
 
6.1.6 Service (Windows NT/2000/XP/2003) 
The Service options tab shows status of the ClockWatch Service and allows 
you to stop and start the service.  In Windows, a service is a separate 
process that runs independently of any application and that is normally 
active whenever the computer is running. 
 

When enabled, the ClockWatch Service runs when ever the computer is 
running. It functions identically to the ClockWatch application in checking 
the clock and keeping the time correctly set. 
 

Start:  Starts the ClockWatch service that is not running.  

Stop:  Stops the ClockWatch service that is currently running. 

Status:  Shows the current run status of the service. 

Pause/Continue:  Suspends/Resumes the clock synchronization 
activity of the ClockWatch service. 

Re-Register: Registers ClockWatch as a service under Windows. Once 
registered, the service can be started using ClockWatch or the 
Windows Service manager.  

Note:  You can also view the status, start and stop the service from the 
Services applet in the Windows Control Panel.  To start the ClockWatch 
service automatically every time Windows starts, set the service 
startup type to 'Automatic' in the properties for ClockWatch.  
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7.0 Technical Reference 
 
Client Setting Log File Format  
This section explains how to interpret the ClockWatch Enterprise client 
clock setting log. This log is updated each time a setting is made on a 
client. 
 
A sample of the Log is: 

Synchronization Log          9/14/03 11:43:12 AM  
Date     Time      Difference Accuracy  Status Client 
-----    ----      ---------- --------  ------ ------ 
03-09-14 11:42:37   2        10.0        5     clientA 
03-09-14 11:52:28   0         0.0        5     clientB 

 
The first line is the title and includes the date and time the log was first 
used. 
 
The second line contains the column headers; these include:\ 

Date: The date the setting was made (yy-mm-dd). 

Time: The local time the setting was made (hh:mm:ss). 

Difference: The difference in the client time from the 
CWEnterpise time. 

Accuracy: The rate of clock drift in time in terms of seconds 
per day. 

Status: The results of the setting. For an explanation of 
codes see Status Result codes on page 42. 

Client: The name of the client whose time was set.  

 
Action Log File Format   
This section explains how to interpret the ClockWatch Enterprise Action log. 
This log is updated each time a function is attempted. 
 
A sample of the Log is: 

Action Log                   11/17/03 12:57:14 PM  
Date Time Action    Result   Client         Arguments 
03-11-17 12:57:14  Run      0      192.168.2.165  C:\Program 
Files\Axialis\AX-Icons\AXIcons.exe 
03-11-21 16:58:49  Run      0      192.168.2.167  Windows Logoff 
03-11-21 17:05:50  Run      0      192.168.2.165  Windows Logoff 
03-11-21 17:07:05  Run      0      192.168.2.165  Windows Logoff 
03-11-21 17:20:52  Relay    0      192.168.2.167    M 7 On  
03-11-21 17:37:47  Relay    0      192.168.2.167    M 7 On  
03-11-21 18:17:30  Relay    0      192.168.2.167    M 7 On  
03-11-22 16:10:37  Relay    0      192.168.2.167    M 7 On  
03-11-22 18:10:03  Relay    0      192.168.2.167    M 1 Off  
03-11-22 18:10:24  Relay    0      192.168.2.167    M 1 Off  
03-11-22 18:10:58  Relay    0      192.168.2.167    M 7 Off  
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The first line is the title and includes the date and time the log was first 
used.  The second line contains the column headers: 

Date: The date the setting was made. 

Time: The local time the setting was made. 

Action The difference in the local time from the adjusted 
client time. 

Result: The rate of clock drift in time in terms of seconds 
per day. 

Client: The results of the setting. For an explanation of 
codes see Status Result codes below. 

Arguments: The name of the client used to make the setting. 
Direct modem connections will show the phone 
number dialed. 

 
Status Result Codes 
The status result code show the result of an action attempt. 
 

Code Result Description   

‘0’ ACTION_OK Action complete. 

‘1’ Date or time invalid    Date/time string is invalid         

‘2’ Time zone error  Time zone is missing. Internal error. 

‘3’ Date Difference  Dates don’t match. Setting new date 

‘4’ Large Time Diff           Time difference exceeds max allow in single 
setting 

‘5’ Time within tolerance  Time difference too small—no need to 
change. 

‘7’ Time setting OK Time set complete. 

’9’ Corrupt command String was corrupt or format was wrong" 

‘15’ Clocks in Sync       Clocks in sync, no need to set  

’33’ Bad Timeserver  Incompatible timeserver 

‘100’ Client Error Client not currently available. 

‘200’ Parse Error Parsing return failed: format setting was 
wrong or time string was corrupt. 

 
System Demands of ClockWatch Enterprise   
The demands of ClockWatch Enterprise, when used in most modes, are 
minimal.  
 

Sequence of Events when making a setting:  ClockWatch Enterprise 
requests a Windows socket (Winsock) type connection to the client. 
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• ClockWatch Enterprise receives the time string from the client. 

• ClockWatch Enterprise converts and compares the client time to local 
time. 

• A setting is set to be made if there is a difference. 

 
LAN Traffic: Since the communication over the LAN is minimal ClockWatch 
Enterprise should not have any significant impact on communications 
traffic.  One packet is received for each setting request. 
 

System Resources: ClockWatch Enterprise spends most of its time in the 
sleep mode, waiting for a scheduled setting to occur or waiting for user 
input. ClockWatch Enterprise uses one of the native operating system 
timers, which are finite in number. 
 

Testing has shown that most users experience approximately a 1% 
increase in system utilization when viewed by the NT System Monitor when 
in the sleep mode with less than 5% increase when actually making a 
setting. 
 

ClockWatch Enterprise Specifications  
 
System Requirements—host computer 

• Windows 95/98/Me/NT/2000/XP/2003. 

• LAN connection to clients. 

• Install ClockWatch Enterprise for client monitoring and/or control. 

• Install ClockWatch for external time synchronization (optional). 

System Requirements—client computer(s) 
• Windows 95/98/Me/NT/2000/XP/2003. 

• LAN connection to host. 

• Install Enterprise Client Service Module - only required for advanced 
features. 

Accuracy 

• Sets client clocks within +/-0.1 second of ClockWatch Enterprise. 

Network Connection 
• Uses a WinSock connection for communication. 

• The local TCP port used for the connection to a proxy server is user 
selectable. 

• ClockWatch Enterprise Server and ClockWatch Enterprise Client 
typically use port 1001 to communicate. 
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8.0 Troubleshooting 
This section offers suggestion for some of the more common issues.  
Additional help is available at http://www.beaglesoft.com/
clwatroubleshooter.htm 
 
The registration window appears at software startup and shows the 
message, “This software must be registered”. 

• Be sure to type the keycode EXACTLY as shown on your confirmation 
email and/or CD envelope.  All letters are capitalized.  

• Check that you have installed the correct ClockWatch Edition.   The 
Software Registration window shows installed edition (just beneath 
“Beagle Software).  If you have installed the wrong edition, simply 
reinstall Enterprise (no need to uninstall the existing edition).  

• Check that the software version matches the version you 
purchased.   If you have re-downloaded the application from our 
website the version may be more recent than your purchased 
software.  Contact Beagle Software, support@beaglesoft.com or call 
612-370-1091 for assistance.  

• The Windows System Registry has been altered or corrupted: Re-enter 
the keycode to re-register the software.  

 
If after installing ClockWatch Enterprise you get a runtime 
error when starting ClockWatch Enterprise such as: 

Run time error “372” - failed to load control 
CommonDialog from COMDLG32.OCX - your version of 
COMDLG32.OCX may be outdated. 

Or 
OLEAUT32.dll is out of date. A newer version is 
required for this program. 

This indicates that the common control that ClockWatch Enterprise uses 
was not installed during installation and needs to be updated.  
 
To update the file, follow these steps: 

1. Identify the name of the control by reading the error message. 
Controls have file names that end in “OCX” or “DLL”. Write down the 
name of the control. 

2. Open an MS-DOS window by clicking "Start," drag to "Programs," then 
click on "MS-DOS Prompt." This will open the "MS-DOS Prompt" 
window. You should see a C:\WINDOWS> prompt. 

3. Type "cd system" (do not type the quotation marks) and press 
<Enter.> This will change the prompt to C:\WINDOWS\SYSTEM>. 

4. Rename the older version of the control identified in step 1 by typing  
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“ren control control.old”  for example  "ren comdlg32.ocx  
comdlg32.old" and press <Enter> (again, do not type the quotation 
marks.)  

5. If your Run Time Error message specifies a different file, replace 
"comdlg32" with your specified file.] This will rename the file and 
return the prompt to C:\WINDOWS\SYSTEM>. 

6. Close the "MS-DOS Prompt" window by clicking the X button in the 
top right corner. 

7. Reinstall ClockWatch Enterprise over the existing installation, 
updating the control. 

If you are still experiencing problems please contact Beagle Software 
support with the exact text of error message you are seeing, 
support@beaglesoft.com. 
 
ClockWatch Enterprise won't make setting 

• Check that the connection to the LAN is working by “pinging” the client. 

• There is no LAN connection to the client selected. 

• Check the Network control panel. 

• Enterprise is set in the Manual mode and no settings have been made. 

 
Logs don't show anything 

• No clock settings have been needed: difference and accuracy are both 
“0”. 

• No reading has been made since startup. 

• The log file has not been specified or is turned off (Previous Settings 
Graph only). 

 
‘Address in Use’ or ‘Can’t Reset Server’ Error Message 
This is usually due to the TCP port that the Client-Server communication 
normally uses is being used by another application or is otherwise 
unavailable.  ClockWatch Enterprise uses port 1001 for Client-Server 
communication. If another application is using this port then ClockWatch 
Enterprise is unable to open it and complains.  
 
The address can be changed on both ClockWatch Enterprise and Client. 
 
Won't log to file 

• Logging is off or no file has been specified to write the log to. 

• File system is full. 
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How to run the Diagnostic Routine 
ClockWatch Enterprise includes a detailed trace mode that gives detailed 
information about connection and communication information useful in 
debugging communication problems. You can run ClockWatch Enterprise in 
the trace mode, which provides a detailed log to pinpoint problems, by 
simply adding the debug option to the command line when starting 
ClockWatch Enterprise.  
 
The following steps will run ClockWatch Enterprise in the trace mode and 
allow you to view the trace log file, DebugFile.txt. 
 

1. Run ClockWatch Enterprise in diagnostic mode by running 
ClockWatch Enterprise from the command line with the debug 
option.  Usually: 
"C:\Program Files\Beagle Software\ClockWatch 
Enterprise\CWEnterprise.exe" debug 

2. Run the problem until the connection fails or problem occurs. Exit 
ClockWatch Enterprise.  

3. View the diagnostic trace, DebugFile.txt, usually in the main 
ClockWatch Enterprise directory: 
C:\Program Files\Beagle Software\CWEnterprise\DebugFile.txt 

4. Check for “ERRORS” or connection problems in the trace. 

5. Beagle Software support personnel can provide detailed analysis of 
the trace.  Email the file to support@beaglesoft.com with your 
contact information and a brief explanation of the problem. 
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9.0  Obtaining Technical Support 
 
Web site: www.beaglesoft.com 
Consult our Web site for the laatest product updates, technical information 
and documentation. 
 
E-mail: support@beaglesoft.com 
Please be as specific as possible including the program version and the 
steps to recreate the problem, if possible. 
 
Phone:  612-370-1091 
Fax: 612-435-4952 
Address: Beagle Software 
 800 Washington Ave N, Ste 418 
 Minneapolis MN  55401  USA 
 
Return Policy 
Beagle Software offers 30-day free trial for all software.  As such, refunds 
are not issued for software-only purchases.  Exception will be made in 
cases where the customer was not able to download the trial and instead 
bought the software.  In these pre-approved cases, Beagle Software offers 
a 30-day money back guarantee.   Refunds are not issued for shipping 
charges. 
 
Return Procedure 
For any Guarantee or Limited Warranty return, please contact Beagle 
Software’s Customer Service line at or 612-370-1091 or  
support@beaglesoft.com to initiate a return.   
 
Please note the following: 

• All physical product (hardware, CDs, manuals) returned to Beagle 
Software for service or credit must be accompanied by a copy of the 
original invoice.   

• Freight on returned items must be prepaid by the customer, and the 
customer is responsible for any loss or damage caused by the courier 
in transit.   

• Include a contact name and daytime phone number for Beagle 
Software to call for clarifications. 

• Software must be uninstalled.  Beagle Software will provide an 
agreement that must be signed and returned to Beagle Software.  
Refunds will not be processed until this agreement is received. 
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Warranty/License Agreement 
ClockWatch® Copyright© 2004 by Beagle Software. All rights reserved. 
 
License Agreement 
You should carefully read the following terms and conditions before using 
this software. Use of this software indicates your acceptance of this license 
agreement and warranty.  Please contact Beagle Software for information 
on distributing the shareware evaluation version of ClockWatch. 
 
Registered Version 
One registered copy of ClockWatch can be installed on a single workstation 
and used by one or more people. 
 
Limited Warranty 
Beagle Software warrants that this product will perform in accordance with 
the included documentation for a period of 180 days from the date of 
receipt and that Beagle Software will, at its own discretion, make 
commercially reasonable efforts to solve any problem issues.  This Limited 
Warranty is void if failure of the software product has resulted from 
accident, abuse or misapplication. 
 
Governing Law 
This agreement shall be governed by the laws of the State of Minnesota, 
USA. 
 
Limitation of Liability 
This software and the accompanying files are sold “as is” and without 
warranties as to the performance of merchantability or any other 
warranties whether expressed or implied.  No warranty of fitness for a 
particular purpose is offered.  Good data processing procedure dictates 
that any program is thoroughly tested before relying on it.  The user must 
assume the entire risk of using the program.  Any liability of the seller will 
be limited exclusively to product replacement or refund of purchase price. 
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Beagle Software offers a complete line of  
premier time synchronization products.  

  
Consult our Web Site for more information and updates. 
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